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Sending Timecode from Reaper to Titan on
another PC

This is an example of how to use Reaper - a much more powerful DAW (digital audio workstation) than
Winamp - to send timecode to Titan, assuming both are installed on two separate PCs. MIDI is being
sent over network using rtpMIDI.

Prerequisites

1. of course both computers need to be networked and configured properly (same network mask,
correct IP addresses etc.)

2. Titan PC-Suite, from v12 on (External AvoKey or T2 required - T1 or Editor Avokey does not
work)

3. rtpMIDI (see Software List, to route the MIDI signal from one computer to the other

Reaper (see Software List)

5. you may consider using the vWIMTC plugin for Reaper in order to have timecode also when
stopped or paused

P

Make it run

1. rtpMIDI

This needs to installed on both machines. rtpMIDI provides a virtual MIDI port which is then bein
forwarded over the network to other participants of this session. There is a compact tutorial provided
at the rtpMIDI website. Usually setting this up is as easy as checking the session is enabled in both
machines, and both see each other.

The two pictures show the setup which was used in the a.m. youtube video - SB-HP is the laptop
running Titan while rtpl is the session on the laptop running Reaper.
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' rtpMIDI on the computer running Reaper

| found that Titan is allergic to MIDI ports being added or removed while Titan is running.
The safest route is, after installing and configuring rtpMIDI, to completely restart the

computer which runs Titan.

2. Titan PC Suite

In order to initially watch the timecode open a timecode workspace window (e.g. Timecode 1) and

select MIDI as timecode source.

Timecode 1

00:00:00.00

3. Reaper

Disabled

Launch Reaper. Load a track if you want (not required for this to function). However here are the

steps to configure Reaper correctly:

https://www.avosupport.de/wiki/

Printed

on 2025/12/10 03:38


https://www.avosupport.de/wiki/_detail/external/examples/rtpmidi_sbhp.png?id=external%3Aexamples%3Areaper_timecode_on_other_pc
https://www.avosupport.de/wiki/_detail/external/examples/rtpmidi_acer.png?id=external%3Aexamples%3Areaper_timecode_on_other_pc
https://www.avosupport.de/wiki/_detail/external/examples/timecode_window.png?id=external%3Aexamples%3Areaper_timecode_on_other_pc

2025/12/10 03:38 3/15 Sending Timecode from Reaper to Titan on another PC

3.1 Enable MIDI Output

In the Options menu select Preferences - this opens the preferences window. Find MIDI devices in
the Audio section. This should list the virtual MIDI port you created in rtpMIDI as MIDI output:

—
|

G REAPER Preferences

MIDI Devices a | MIDI hardware settings

Buffering MIDI inputs to make available (selectable as track inputs and/or leamable or action-bindable):

Mute/Solo Device - Mode ID
Playback

Seeking g Enabled+Control 0

Recording

Loop Recording

Rendering
Appearance

Media

Peaks\Waveforms

Fadez/Crossfades ) i Add joystick MIDI...
Track Cortral Pansls MIDI outputs to make au.?‘l\!able (selectable as track outputs):

Editing Behavior Device Mode D

Envelope Display Microsoft GS Wavetable Synth Juse cautiously]  <disabled: 1]

Automation tp Enabled 1
Mouse

et

Mouse Modifiers

MIDI Editor
Media

MIDI

Video Import/Misc Restrict MIDI hardware output to one thread Reset all MIDI devices

Plug-ns
Compatibility v | Pesetby: [v]Alnotes-off Pitch/sustain Reseton: []Play [ ]Stop/stopped seek

[ ] Find Cancel | IR

Right-click on the port in the output section and either tick Enable output from the menu...
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ﬁ REAPER Preferences —T >
MID| Devices » | MIDI hardware settings
Buffering MIDI inputs to make available (selectable as track inputs and./or leamable or action-bindable):
Mute/Solo Device Mode D
Playback
Seeking tp Enabled+Contral 0
Recording
Loop Recording
Rendering

Appearance
Media
Peaks\Waveforms
Fades/Crossfades } i Add joystick MIDI...
Track Contral Panels MID| outputs to make .a'l.railable (selectable as track outputs):

Editing Behavior Device Mode D
E”""El"p? Display Microsoft GS Wavetable Synth Juse cautiously]  <disabled: 1]
Automation tp1 Enabled 1
Mouse ]

Mouse Modffiers Configure output...
MID| Editor
b3

Media Output 1D
MIDI Forget device
Video/Import/Misc .

Reset all MIDI devices

Plug-ns . Enable output

Compatibility " Send clock to output Play []Stop/stopped seek
I:I Find E::iba::fs:'; Do not send 5PP to output E Cancel Aoply
Low latencv outout mode (low orecision]

... or select Configure output.. and make the settings there:

https://www.avosupport.de/wiki/ Printed on 2025/12/10 03:38


https://www.avosupport.de/wiki/_detail/external/examples/reaper_rtp2.png?id=external%3Aexamples%3Areaper_timecode_on_other_pc

2025/12/10 03:38 5/15 Sending Timecode from Reaper to Titan on another PC

ﬁ REAPER Preferences _‘T_ %
MID| Devices A | MID| hardware settings
- B — ! A—-———ghle as track inputs and/or leamable or action-bindable):
ﬁ Configure MIDI Output X
M
3 Mode D
5; Device name: |rtp1 | Enabled+Control 1]
RE  Alias name: |m |
Lo
=} Enable output to this device
fppl []Send clock to this deviee [ ] Mo SPP/continue
Ivlg ] Open device in low latencydow precision mode
Pe
Offset output to this device by: o N
_'l'__-: ctable as track outputs): Add joystick MIDI...
3 Cancel Mode D
Ermlay Microsoft G5 Wavetable Synth [use cautiously]  <disabled: 0
Automation tp1 Enabled 1
Mouge
Mouze Modifiers
MIDI Editor
Media
MIDI
Pl"n.ﬁd»:an,-’lmpc:rtfl'tﬂisc Restrict MIDI hardware output to one thread Reset all MIDI devices
Lig-ns
Compatibility w | Pesstby: [ Alnotesoff Pitch./sustain Resst on: [A|Play [ ]Stop/stopped seek
Enable the MIDI Ouwtput devices you wish to use by right-clicking on the Device [
|:| Find name and selecting Enable Qutput. Ok Cancel Apply

Confirm the settings with OK to close the preferences window.

3.2 Insert Timecode Generator

Rewind the timeline to 0:00:00 (simply press <Pos 1>). From the Insert menu select SMPTE LTC/MTC
Timecode Generator. This inserts this generator as new track.
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zct] - REAPER wB.08/x64 - Registered to Termporary License (Commercial license, &

Insert  Itermn  Track Options  Actions Help [Insert timecode generator
Media file... EIMFG
Mew MIDI item
Empty item

SMPTE LTC/MTC Timecode Generator

I Click source
Mew subproject
Marker M
Marker (prempt for name) Shift+M
Region (from time selection) Shift+R
Tempe/time signature change marker Shift+C
Measure from time selection (detect tempa) Alt+5hift+C

Measure from time selection (new time signature)...

Track Ctrl+T
Multiple tracks...
Yirtual instrument on new track...

Track from template -]

Empty space at time selection

If you had already inserted an audio track then probably the timecode track was inserted on the same
track. Simply click, drag and drop it onto a new track:

03_trust-il - FX

Also, it's a good idea to bring the timecode track (at least) to the same length like the music:
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3.3 Adjust Timecode Generator

Right-click on the new timecode track, and from the context menu select Item properties:

[tern settings
[temn properties... F2
Source properties... Ctrl+F2

Group
Take
Comps

[term and take colors

[temn processing

Stretch markers

(or, with the timecode track selected hit F2).

This opens the Media Iltem Properties window:

AVOSUPPORT - https://www.avosupport.de/wiki/


https://www.avosupport.de/wiki/_detail/external/examples/reaper_rtp6.png?id=external%3Aexamples%3Areaper_timecode_on_other_pc
https://www.avosupport.de/wiki/_detail/external/examples/reaper_rtp7.png?id=external%3Aexamples%3Areaper_timecode_on_other_pc

Last
update:
2020/04/29
09:43

external:examples:reaper_timecode_on_other_pc https://www.avosupport.de/wiki/external/examples/reaper_timecode_on_other_pc?rev=1588153412

Media [tem Properties: Timecode Generator '¥'

]
|
|
|
[ |

If you want then you can change length, position and other details. In any case you need to make
sure it is MTC (MIDI timecode): click on the Properties button (at the bottom). In the new little
window set the properties to Send MIDI (MTC):
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Media ltem Properties: Tirmecode Generator ¥

0:00.000

Track/project default timebase e

Project default tem mix behavior w

6 SMPTE Generator Properties

() Send audio (LTC)  (®) Send MIDI (MTC)
Frmrit&:|3ﬂ_|]] v|

Start time: [0.00:00:00 | thh:mm:ss ff)

User value 1 (0-255):
User value 2 (0-255):
User value 3 (0-255):
User value 4 (0-255):

Confirm/close both windows by clicking OK.
3.4 Route the MTC signal

This button slightly depends from your reaper version:

In Reaper v5, click on the routing button in the track controls (left to the timecode track):

or=E i

Sends, Receives, and Hard

© B ED >

In Reaper v6, right-click on the volume knob ov the timecode track.

This opens the routing window for this track. Under MIDI Hardware Output (top-right) select your
virtual MIDI port:
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Routing for track 2 "" n
Master send Eehame=l -2 - MID| Hardware Output -
itp1 v
[o.ooEE= Track channels: 2 \p—ﬁ |
ED [D Send to original channels e
Pan: |certer | Width: | 1007 | () - Receives -
[ Playback time offset: ' +0 | Ims | samples | Addnew receive... i
- Sends -
Add new send... w
- Audio Hardware Outputs -
Add new hardware output ... e

Close the routing window.

4. Try it out

Essentially this should work straight away: as soon as you hit Play in Reaper, the timecode value in
Titan starts to run. It is advisable to change the time units in Reaper: right-click on the timeline or the
displayed time, and from the context menu select Hours:Minutes:Seconds: Frames.

This also works together with Reaper being controlled by Titan via MMC, like described in Controlling
Reaper from Titan on the same PC
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0:00:10.19

Disabled

| Groups

1 2
All Dimmer [ Dimmers]

You can now use this as timecode source to sync cuelists to music coming from Reaper.

| noticed a gap between the timestamps in Reaper and in Titan. This seems to be due to both, Reaper,
as well as Titan/USB Expert, and needs to be investigated further.

5. How to debug

If things do not work as expected then there are some tools which help finding the fault:

5.1 loopMIDI

You may route the signal via loopMIDI as explained in Sending Timecode from Reaper to Titan on the
same PC. Please install loopMIDI and apply the correct settings in Reaper.

Also, in this case rtpMIDI needs to be told to take its input from loopMIDI:
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(&) rtpMIDI: Gber Apple Bonjour >

Konfiguration  Erweitert Ober

Meine Sessions Session

oo & Aksviert 5004
ripl
ripl

+| |- Teilnehmer: | Mame Latenz
SB-HP 1 ms

Verzeichnis

Trennen
Adresse; DESKTOP-5VQ 1J4V: 5004
2.0.0, 1:5004
192,168,173, 59: 5004
+|| - Verbinden
Diese Benutzer dirfen sich mit mir verbinden gooMIDT Port w | - Q
Alle w | - - | —

loopMIDI shows the number of transmitted data. This number increases with every command, note or
message. With timecode, this number increases continuously and rather fast.

P o)

(&) loopMIDI ==
Konfiguration | Erweijtert | Uber

Meine Loopback MIDI-Ports

MName Durchsatz [ Sek.

0 Byte

: loopMIDI Port

E]E] Meuer Port-Mame: loopMIDI Port 1

5.2 USB Expert Console

Open the USB Expert Console. This must show your virtual MIDI port as connected panel (top-left).
Select the MIDI tab top-right, click Watch MIDI, in the MIDI watcher window select MIDI Input and
Raw MIDI. Now, as you send a command, it is shown in the MIDI watcher, with continuously incoming
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data like this:
LI
File  Tosls  Remote  Help
€ Reset 3 Surpend e Eventy ko Serice Ted Bench MO Tiecode
Fae Shire o Hike
Cormected Farut
PE —— & Luda O] Vecters BB-HP 1
= 5?‘ | [ Fadem [ Tesa Starp M Walcher
UoT2OMX] b tha rarm MIDH data on e
i prm—— o NZEITH
D Inprt . - el
" e L —l Cormnard Diata Data 2
B0 7E 00 BX 7B 00 B3 TE 00 BS TB 00 Bl THB 00 BE TH 00 Bd
78 00 BE 7B 00 BT 7B 00 B% 7B 00 BA TB O0 BC 7B 00 BE 7B v |Empty
= BD 7B 00 BE TE OO BF TE OO0 EO0 OO0 40 E1 OO0 40 EI OO 40 I
E4 00 40 E6 00 40 E2 00 40 E7 O0 40 ES OO0 40 EB 00 40 ES Cand
00 40 EA 00 4% EB 00 40 EC 00 40 EE 90 40 EF o0 40 BO 40
G0 Bl 40 00 B2 40 00 B3 40 00 B3 40 00 54 40 O0 ED OO 40
BT 40 00 B& 40 00 BE 40 00 BS 40 00 BA 40 00 BE 40 00 BC
<40 00 BD 40 00 BE 40 00 BDF 40 OO0 FO TP TP 01 ©1 &0 OO0 OF
St Messages | OF F1 FL 50 00 F1 60 00 F1 Té @0 F1 00 o0 F
Filar 0 Fl ) FL 30 00 FL 40 00 F1 50 00 F1 &0 OO ¥
F1 o2 1 100 FL 2% 00 FL 30 00 F1 40 OO0 F1 54
&0 00 6 00 FL 04 00 FL 11 OO0 F1 35 00 F1 oD
" r1 ) FL 60 00 FL 76 00 F1 06 90 F1 11 @0 Fl
F1 30 L 08 FL S0 00 FL 80 00 F1 TE 00 F1 o8
11 00 FL 2% 00 FL 30 00 F1 40 00 F1 50 00 F1 oD
0 F1 0 00 L 1L 00 FlL 2% 00 Fl 30 90 F1 40 1
Fl 6 00 FL OC 00 FL 11 00 F1 5 OO0 F1 30 00 Fl
40 00
Cluar (="

@ ACW USH pernice connecied...

Additionally, on the Timecode tab (top-right), you should see the real timecode values running:

01 UsB Bapert Conuole 8.7.71.% - a x

File  Tocie Femote Help
 Ruset 3 Sunpand bore: Everie b2 Sevice Tes Bance MO0 [ Trecode
Cormcied Parsts Fler ?‘c" Hede [CIRTR
56+ (=g [ vemas
= G20k 1 5 Faden [ Ties S i Trracnde
) [ Whesta [ Fisasen . . . |
B2 swere = - e 00:00:09:26 0
[[] Wiras Facher Ol Terecads
- L] L]
00:00:00:00
Tirsacxcs Contel
Siat S Resm
Ot Tanecad Tiggen [
Szt Meaayed X Delete b Go
Filler x
Lsgend Simet Time Sizp Tire Leop
]
Cirar Dear Trgoes L Add Triggss

& ADW USH werace connected...

5.3 MIDI-OX

Another great tool for fault finding (but also for fault generating) is MIDI-OX. One of the things you
should be aware of is that it may take the MIDI signal and doesn't forward it unless told to do so - you
may see proper MIDI messages and wonder why nothing is passed on, and as soon as you close MIDI-
OX, suddenly everything works flawlessly. You have been warned... (Thus, usually use this together
with loopMIDI in order to tap into the signal)

Install and launch MIDI-OX (see Software List. From the Options menu select MIDI Devices. Make
sure loopMIDI Port is listed as MIDI Input but isn't mapped to any output (yes, you can create a
feedback loop, and yes, you do not want to do this...)
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i MIDI-OX - [Monitor - Input]
ﬁ File View Actions Options
FZe HESHE

Window Help

=

[=]
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24

TIMESTAMF IN PORT STATUS DATA]1 DATAZ CHAN NOTE EVENT

&% MIDI Devices

Fresets: - @IEI [ k. ] | Cancel
Part bMapping:
MID| Outputs: Part Map Objects:
1] Microzoft G5 Wavetable Synth & Channels
2] loopMIDI Port A System
3 MIDT Mapper @ loopMID| Part
& MIDI-0% Events
dn) _MO=SYSMAPT osm
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From the View menu select Input Monitor... In this window, all incoming MIDI data are shown. You

will see the cpntinuous stream of MTC Quarter Freame messages:
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